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1 Important notes 
 
Definition of the individual target groups: 
 
Design of safe drive systems: 

- Engineers and technicians 
 
Mounting, electrical installation, maintenance and device replacement: 

- Industrial electricians and service engineers 
 
Commissioning, operation and configuration: 

- Technicians and engineers 
 

1.1 Definitions 
 
The term PSC1 is used as the generic term for all derivatives of the PSC1 product line. If 
reference is made to a specific derivative in the description, the complete identifier is used.  
 
COM is the abbreviation for the universal communication interface of the PSC1. 
 
The term "safe" used in the following refers to categorisation as a safe function for usage 
from PL b according to EN ISO 13849-1 or SIL1 according to EN 61508. 
 
The programming software "SafePLC2" is used to configure and program the PSC1 
modules. 
 

1.2 Other applicable documents 
 

Description Reference 

General information on PSC1 
modules and their use  

Installation manual PSC1-C-10, 
Installation manual PSC1-C-100, 
Programming manual SafePLC2 

Table 1: Other applicable documents  

 

 Note: 
 

• Read manuals carefully before you start the installation and 
commissioning of the PSC1 module. 

• Following the documentation is a prerequisite for trouble-free 
operation and the acceptance of claims under the warranty. 
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1.3 Abbreviations used 
 
 

Abbreviation Meaning 

AC Alternating Current 

IL Instruction List 

BGIA (IFA) Institute for Industrial Safety at the German statutory accident prevention 
body 

CLK Clock 

CPU Central Processing Unit 

DC Direct Current 

DIN Deutsches Institut für Normung 

EDS Electronic Data Sheet - EtherNet/IP 

EMC Electro Magnetic Compatibility 

EN European Norm 

ESI EtherCAT XML Device Description 

ETG EtherCAT Technology Group 

GSD General Station Description 

GSDML General Station Description Markup Language 

IPxx Degree of protection for housing 

ISO International Organisation for Standardisation 

LED Light Emitting Diode 

PLC Programmable Logic Controller 

POR Power on Reset 

SDDC Safe Device To Device Communication 

SELV Safety Extra Low Voltage 

SSI Synchronous Serial Interface 

VDE Verband der Elektrotechnik, Elektronik und Informationstechnik e. V. 

Table 2: Abbreviations 
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2 Safety instructions 

2.1 Intended use  
 
The universal communication interface COM is an extension for the modules PSC1-C-10-x-
FB1, PSC1-C-10-x-FB2, PSC1-C-100-FB1, PSC1-C-100-FB2 and their variants for non-safe 
data transmission via an Ethernet, or CAN or RS485 based protocol. 
 
The COM interface also has the following options: 

• Safe data transmission via safe fieldbus protocols 

• Safe Remote I/O Communication (SDDC) 

• Safe cross communication (SMMC) 

• SD bus communication  
 

These options are described in separate manuals.  
 
The option: Memory Card (SDHC) is described in the PSC1-C-10/100 installation manuals. 

2.2 General safety instructions 
 
 

Safety instructions: 
 

• To prevent injury and damage, only qualified personnel are allowed to work on the 
device.  Qualified personnel are personnel who have electrical engineering 
apprenticeship and who are familiar with the applicable rules and standards of 
electrical engineering.  
 
The qualified person must become familiar with the operating instructions 
(cf. IEC 364, DIN VDE0100). 

 

• The qualified person must have, as a minimum, detailed knowledge of national health 
and safety regulations. 

 

• The usage of the devices is to be limited to their intended usage as per the list given 
above. The values in the data listed in Section "3.Device description and function"  
are also to be met. 

 

• The content of these installation instructions is limited to the basic function of the 
devices and their installation. The programming of the devices and re-configuration of 
the device parameters is further described in the "Programming manual SafePLC2".  
Detailed knowledge and understanding of this information is a vital prerequisite for a 
new installation or the modification of the device function or device parameters.    

 

• Commissioning (i.e. commencing operated as intended) is only 
allowed on compliance with the EMC directive.  

 

• It is imperative that the wiring and connection notes from the Sections "0.  
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• Equipment and settings" and "5. Connection and installation" are followed. 
 

• The applicable VDE regulations as well as other special  
safety regulations for the specific application are to be followed.  

 

• Never install or place in operation damaged products. Please report damage  
to the carrier without delay. 

 

• Never open the housing and/or make unauthorised modifications. 
 

• Inputs and outputs for standard functions and the digital and analogue data 
transmitted via communication modules are not allowed to be used for safety-related 
applications.  

 
 

WARNING: 
 

The usage of our devices contrary to the rules and conditions stated here can 
result in the injury or the death of persons, as well as damage to the devices and 
machines connected! 
This usage will also render void any claim under the warranty or any claim for 
claim damages against K.A. Schmersal GmbH & Co. KG. 

 

2.3 Operating and service 
 

Prior to installing and removing the module, or disconnecting the signal wires, the module is 
to be electrically isolated. For this purpose, all electrically live supply wires to the device are 
to be switched off and it is to be checked that there is no electrical power present on the 
wires.  
 
During the installation and removal of the module, appropriate measures are to be taken to 
prevent electrostatic discharges on the external terminals and connections. Contact with 
these terminals should therefore remain limited to a minimum; prior to and during this work 
you should be earthed, e.g. using an earthing wrist strap. 
 

2.4 Transport/storage  
 

The instructions on transport, storage and correct handling are to be followed. 
The climatic specifications as per the Section "8.Technical data" are to be met.  
 

  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 10 of 171 

 

3 Device description and function 
 
The universal communication interface COM is permanently integrated in each basic module 
with the option FB1 or FB2.  
In this connection, the COM interface is responsible for non-safe data transmission via 
Ethernet or CAN or RS485-based bus protocols. 
 
Depending on option FB1 (EtherNet/IP, PROFINET, EtherCAT) or FB2 (PROFIBUS, 
CANopen), all fieldbus protocols associated with the options are stored in the COM interface.  
 
These can be selected and configured in SafePLC2. Type and number of data are also 
defined in SafePLC2. For PSC1-C-100-FBx systems, a choice of 3 different transmission 
profiles is also available. 
Please observe the notes in the corresponding chapters in the "SafePLC2 Programming 
Manual". 
 
The COM interface receives data from the application program running on the PSC1 and 
forwards it to a higher-level standard controller via the bus protocol selected and configured 
in the SafePLC2 programming system. 
 
The data can be further processed there. The non-safe diagnostic data consist of logic data 
and process data. 
The process data can contain position values, speeds and other analogue values of the axis 
monitoring modules, which are either integrated into the basic module (PSC1-C-10-x-FBx) or 
connected to it via the backplane bus (PSC1-C-100-FBx).   
 
In addition, up to 32 non-safe functional inputs are available on the PSC1, via which digital 
information can be received from the higher-level standard controller.  
In the "SafePLC2" function diagram, these inputs must be AND-linked to a safe input and 
can then be reused as required. 
 
For a detailed breakdown of diagnostic data and pre-selectable profiles, please refer to 
Section 9.Input/Output data. 
 
The basic module equipped with a COM interface is always a slave in the network. 
 

A corresponding device description file (EDS, GSDML, ESI, GSD) is required for 
configuration within the programming system of the higher-level controller. 
With EtherNet/IP, the base module can also be configured as a generic Ethernet device. 
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3.1 Fieldbus-specific properties 
 
Note: The MAC-Address printed on the devices represents the MAC-Address of the SDDC 
connection ports. The MAC-Address of the fieldbus ports is derived following the example: 
 
 
 
 
 
 
 
 

3.1.1 EtherNet/IP 
 

Response time Processing time for incoming fieldbus protocols: min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Maximum number of output 
data (O → T) 

68 bytes (1) 

Maximum number of input 
data (T → O) 

192 bytes (2) 
 

IO connection types 
(implicit) 

Exclusive Owner, Listen Only, Input Only 

Max. number of connections 8 (sum of the connected explicit and implicit connections) 

Explicit news  Connected and not connected 

Supported standard objects Identity Object (0x01) 
Message Router Object (0x02) 
Assembly Object (0x04) 
Connection Manager (0x06) 
DLR Object (0x47) 
QoS Object (0x48) 
TCP/IP Interface Object (0xF5) 
Ethernet Link Object (0xF6) 
Time Sync Object (0x43) 

Baud rates 10 and 100 Mbps 

Data transmission Half duplex, full duplex, auto-negotiation 

Data transport layer 
100 MBit/s  

Ethernet II, IEEE 802.3 

ACD 
(Address Conflict Detection) 

Supported 

DLR V2  
(Device-Level-Ring 
topology) 

Supported 

Quick Connect Supported 

CIP sync Supported  

Integrated switch Supported 

Reset services Identity Object Reset Service of Type 0 and 1 

DHCP Supported 

BOOTP Supported 
Table 3: Fieldbus-specific properties EtherNet/IP 

 
(1) Outputs 4 byte; SD bus outputs: 64 byte  
(2) Diagnostic inputs: 128 byte; SD bus inputs: 64 byte  

00:16:22:22:12:34

00:16:22:A2:12:34

& 80h



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 12 of 171 

 

3.1.2 PROFINET IO 
 

Response time Processing time for incoming fieldbus protocols: min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Number of output data 
(cyclic) 

80 bytes (1) 

Number of input data  
(cyclic) 

204 bytes (2) 

Baud rates 100 MBit/s 

Supported protocols RTC – (Real time cyclic protocol (Class 1, Class 2, Class 3) 
RTA – (Real time acyclic protocol) 
DCP – (Discover and Configuration Protocol) 
LLDP – (Link Layer Discovery Protocol) 

Topology detection LLDP, SNMP V1, MIB2, physical device 

Data transmission Half duplex, full duplex, auto-negotiation 

Data transport layer 
100 MBit/s 

Ethernet II, IEEE 802.3 

Table 4: Fieldbus-specific properties PROFINET 

 
(1) Outputs 4 byte; SD bus outputs: 64 byte; safe outputs: 12 byte 
(2) Diagnostic inputs: 128 byte; SD bus inputs: 64 byte; safe inputs: 12 byte 

 
 

3.1.3 EtherCAT 
 

Response time Processing time for incoming fieldbus protocols: min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Number of output data 
(cyclic) 

95 bytes (1) 

Number of input data  
(cyclic) 

219 bytes (2) 

Baud rates 100 MBit/s 

Type Complex slave 

Number of sync managers 4 (2 acyclic, 2 cyclic) 

Distributed clock supported, 32 bit 

Supported protocols CoE 
EoE 

Data transmission Half duplex, full duplex, auto-negotiation 

Data transport layer 
100 MBit/s 

Ethernet II, IEEE 802.3 

Table 5: Fieldbus-specific properties EtherCAT 
 

(1) Outputs 4 byte; SD bus outputs: 64 byte; safe outputs: 27 bytes (3) 
(2) Diagnostic inputs: 128 byte; SD bus inputs: 64 byte; safe inputs: 27 bytes (3) 
(3) 12 bytes user data + 12 bytes CRC + 2 bytes Connection ID + 1 byte Master Command 

 

  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 13 of 171 

 

3.1.4 Modbus TCP/IP 
 

Response time Processing time for incoming fieldbus protocols: min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Protocol TCP/IP 

Address range 260 Byte  

Coils 1..32 

Discrete Inputs - 

Input Register 1..64 

Holding Register 1..130 

Max number of connections 1 

Supported objects 0x01 - Read Coils  
0x03 - Read Holding Registers 
0x04 - Read Input Registers 
0x05 - Write Single Coil  
0x06 - Write Single Register  
0x0F - Write Multiple Coils  
0x10 - Write Multiple Registers 

Baud rates 10 und 100 Mbits/s 

Duplex modes Half Duplex, Full Duplex, Auto-Negotiation 

Data transport layer Ethernet II, IEEE 802.3 

Modbus Port 502 

Tooling Port 50000 

Integrated switch yes 

IP-settings DHCP supported 

BootP supported 

Fixed IP supported 
Tabelle 6: Feldbus-spezifische Kenndaten Modbus TCP/IP 
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3.1.5 PROFIBUS 
 

Response time Processing time for incoming fieldbus protocols: min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Number of output data 
(cyclic) 

80 bytes (1) 

Number of input data (cyclic) 204 bytes (2) 

Device class  DP Slave 

Baud rates 9.6 kBit/s up to 12 MBit/s 

Supported state machines FSPMS, MSCY1S, DMPMS, MSAC1S, MSAC2S, 
MSRM2S 

Data transport layer PROFIBUS FDL 

Freeze Mode Supported 

Sync Mode Supported 

Auto baud rate Supported 
Table 7: Fieldbus-specific properties PROFIBUS 

 
(1) Outputs 4 byte; SD bus outputs: 64 byte; safe outputs: 12 byte  
(2) Diagnostic inputs: 128 byte; SD bus inputs: 64 byte; safe inputs: 12 byte 
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3.1.6 CANopen 
 

Response time Processing time for incoming fieldbus protocols: 
min.1 ms; 
Response time depends on the PSC1 system: 
see installation manual PSC1 
 

Number of output data 
(cyclic) 

68 Byte (1) 

Number of input data 
(cyclic) 

192 Byte (2) 

Number of RPDO 5 

Number of TPDO 20 

Exchange of process data via PDO  

Acyclic communication via SDO  
Emergency message (producer), 
Timestamp (producer/consumer) 

Baud rates 10 kBit/s to 1 MBit/s 

Functions Node guarding, life guarding, 
Heartbeat, 
PDO Mapping 
NMT Slave 
SYNC protocol (consumer) 
Error behavior in state operational: 

• change to state pre-operational 

• no state change 

• change to state stopped 

Data transport  CAN Frames 

CAN Frame Typ 11 Bit 
11/29 Bit Layer 2 transparent 

Sync Mode Supported 

Auto baud rate Supported 
Table 8: Fieldbus-specific properties CANopen  

  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 16 of 171 

 

4 Equipment and settings 
 

4.1 Ethernet-based device variants (-FB1) 
 
The front panel of the Ethernet-based fieldbus variants displays the following equipment:  
                  

 
 

Figure 1: Front view device variant (-FB1); here PSC1-C-10-FB1 
 

No settings need to be made on the device. 
 
 

  

Diagnostic LEDs 
  (see Section "4.3 Diagnostic LEDs") 

 
Ethernet RJ45 socket for 
Ethernet-based fieldbus variants 
  (see Section "5.5.1 Fieldbus interface connection 

socket with the FB1 option (RJ45 socket)) 



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 17 of 171 

 

4.2 CAN or RS485-based device variants (-FB2) 
 
The front panel of the CAN or RS485-based fieldbus variants displays the following 
equipment:  
                  

 
 

Figure 2: Front view device variant (-FB2); here PSC1-C-10-FB2 
 

The slave address must be adapted according to Section 5.4 "Address selector switch 
 

  

Diagnostic LEDs 
  (see Section "4.3 Diagnostic LEDs") 

 
D-SUB 9P connector for 
CAN or RS485-based fieldbus variants 
  (see Section "5.5.2 Fieldbus interface connection 

socket with the FB2 option (D-SUB- socket)") 
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4.3 Diagnostic LEDs 
 
The universal communication interface has 4 two-colour LEDs, independent of the device 
variant, with which the signal colours orange, green and red are displayed. 
 

 
 
 

 
 
 
 
 
 
 

 

Figure 3: Diagnostic LEDs 

 
  

 No. Name Function 

 

4 Run PSC1 State SDDC/SMMC communication 

3 Bus Fieldbus status 

2 XB Cross communication to the F-CPU 

1 SD SD bus status 
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The following table shows the display functions: 
 

4 / Run  Orange Flashing Initialisation; waiting for connection and reception of the device and 

connection parameters 

  Continuous Wait for logical link to Master-COM 

 Green Flashing Waiting for reception of the device and connection parameters after a 

time-out from the master run 

  Continuous Active process data exchange 

 Red Continuous No link on either port; 

Timeout of the connection from the start-up or master restart state 

3 / Bus Green Continuous EtherNet/IP: Connected 

PROFINET IO: Application relationship (AR) established; active 

EtherCAT: Status operational 

PROFIBUS: Connection active 

CANopen: Status operational 

Flashing EtherNet/IP: - 

PROFINET IO: Bus Link, but no integration 

EtherCAT: Status preoperational 

PROFIBUS: Bus Link, but no integration 

CANopen: Status preoperational 

Short Pulse EtherNet/IP: Waiting for connection to the scanner (bridge)  

PROFINET IO: Bus Link, but no integration 

EtherCAT: Status Safe operational 

PROFIBUS: - 

CANopen: - 

Red Continuous EtherNet/IP: Timeout 

PROFINET IO: Bus error 

EtherCAT: Application Controller Failure 

PROFIBUS: Bus error 

CANopen: Application Controller Failure 

Flashing EtherNet/IP: - 

PROFINET IO: Bus error 

EtherCAT: Error code according to ETG.1300 EtherCAT indicator and 

labelling specification 

PROFIBUS: Bus error 

CANopen: - 

orange Flashing EtherNet/IP: Network/link error; same IP address used 

PROFINET IO: - 

EtherCAT: - 

PROFIBUS: - 

Off - EtherNet/IP: Not active; no MAC address; not initialised 

PROFINET IO: inactive 

EtherCAT: inactive / status initialisation 

PROFIBUS: inactive 

2 / XB Green Continuous SPI connection to F-CPU active and ok 

 Red Continuous  Fault: Timeout for SPI connection to F-CPU 

1 / SD Green Flashing SD bus scan active 

  Continuous Active data exchange 

 Red/orange Flashing Error during SD bus scan 

 Red Continuous SD bus error in cyclic operation 

 Off - No SD bus device (slave) found 

Table 9: Diagnostic LEDs display functions 
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5 Connection and installation 
 
The COM interface requires no additional power supply for safe and non-safe fieldbus 
communication. The interface is supplied directly by the base module.  
 
The bus systems must be installed in accordance with the respective installation instructions 
of the user organisations (ODVA, PNO, ETG, CiA). 
 
The fieldbuses must always be connected to the RJ45 sockets marked FB2.1 / FB2.2 (option 
FB1) or to the D-SUB socket marked FB2 (option FB2), as shown as an example in the 
following figure. 
 
 

 

 
 
 
 
 
 
 
 
 
 

 

 
Figure 4: Example for fieldbus connection to the FB2.1 / FB2.2 (EtherNet/IP) sockets 

 
 
A 2-port switch functionality is integrated for TCP/IP based fieldbus. 
 

5.1 General installation instructions 
 
It is imperative you follow the safety instructions during installation! 
 
Degree of protection IP20 
 
In all circumstances separate voltages of 230 VAC from low-voltage wires, 
if these voltages are used in relation to the application. 
 
Suitable measures must be taken to exclude faults in the event of overvoltage. Suitable 
measures are, for instance, lightning protection for wires outdoors, overvoltage protection for 
the installation indoors, protected cable laying. 
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Measures for electromagnetic compatibility (EMC): 
 

• PSC1 modules are intended to be used with drives and meet the EMC 
requirements stated above.  

• In addition, it is a prerequisite that the electromagnetic compatibility of the overall 
system is safeguarded using customary measures.  

 
 

 Safety instructions: 
 

• It is to be ensured that the power supply wires for the PSC1 and "switching wires" for 
the power converter are laid separately. 

• Signal wires and power wires for the power converter are to be laid in separate cable 
ducts. The distance between the cable ducts should be at least 10 mm. 

• Attention is to be paid to the correct installation in relation to EMC of the power 
converter technology in the area of the PSC1 module. Particular attention should be 
paid to cable routing and the connection of the screen for the motor cable and the 
connection of brake resistor. Here it is imperative the installation guidelines from the 
manufacturer of the power converter are followed. 

• All contactors in the area of the converter must be equipped with an appropriate 
suppressor circuit. 

• Suitable measures for protection against overvoltages are to be taken.  
 

5.2 Installing PSC1 modules 
 
The module is only installed in switch cabinets that meet degree of protection IP54 as a 
minimum. 
 
The modules must be fastened vertically on a DIN rail.  
 
The ventilation slots must be kept adequately clear to obtain the circulation of air inside the 
module.   
 
Further information can be found in the installation manuals for the PSC1-C-10 and PSC1-C-
100. 
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5.3 Assembly of modules and backplane bus 
 

 
 

Figure 5: Assembly 

 
The devices are fitted to the rail from above at an angle and snapped downward.  
 
Further information can be found in the installation manuals for the PSC1-C-10 and PSC1-C-
100. 
 

5.4 Address selector switch 
 
For PSC1 modules with option FB2, two address selection switches are mounted on the 
underside of the COM interface. 
 
 

 
Address High-Nibble 

 
Address Low-Nibble 

 
Figure 6: Address selector switch for PSC1 devices with option FB2 

 
 
The switches represent the hex-Value of the device address. A a decimal 10 (0x0A) would 
be set as an ‘0’ (high nibble) ‘A’ (low nibble) and a decimal 100 (0x64) as ‘6’ (high nibble) ‘4’ 
(low nibble). 
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5.5  Assignment of connection socket 
 

5.5.1 Fieldbus interface connection socket with the FB1 option (RJ45 socket) 
 

 

 
 
 

Pin Name Description Colour 

1 TX+ Transmit Data + white-orange 

2 TX- Transmit Data - orange 

3 RX+ Receive Data + white-green 

4 nc not used blue 

5 nc not used white-blue 

6 RX- Receive Data - Green 

7 nc not used white-brown 

8 nc not used brown 

 
 

 
Figure 7: Fieldbus interface connection socket / FB1 option (RJ45 socket) 

 
 

5.5.2 Fieldbus interface connection socket with the FB2 option (D-SUB- 
socket) 

 

 

 
 

 
Pin Name Description 

1 nc Not used 

2 CAN_N CAN data line negative (in preparation) 

3 PB_P / CCL_P Data line plus (PROFIBUS: B-line) 

4 PB-CNTR_P Repeater direction control plus (OPTIONAL) 

5 GND Bus Data ground 

6 +5V bus 5V supply for bus termination 

7 CAN_P CAN data line plus (in preparation) 

8 PB_N / CCL_N Data line negative (PROFIBUS: A-line) 

9 PB-CNTR_N Repeater direction control negative (OPTIONAL) 
 

 
Figure 8: Fieldbus interface connection socket / FB2 option (D-SUB) 

 
 

6 Modification / dealing with changes to the device 
 
Repair 
It is only possible to repair a device in the factory. 
 
Warranty 
The warranty will be rendered void if the module is opened or modified without authorisation.  
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7 Maintenance 

7.1 Replacement of a module 
 
On the replacement of a module the following sequence should be noted: 
 

• Remove power supply 

• Remove fieldbus connection cable 

• Remove the module from the DIN rail and pack it EMC-compliant 

• Install new module on the DIN rail 

• Connect the fieldbus connection cable 

• Activate power supply 
 
 
 

Note:  
In principle, no plug-in connection on the PSC1 module is allowed to be disconnected 
or connected again while electrically live.  
 
 

8 Technical data 

8.1 Ambient conditions 
 

Degree of protection IP 20 
Ambient temperature 0°C... 50 °C 
Storage temperature: -25°C…70°C 
Service life 20 years in 50 °C environment 

Table 10: Ambient conditions 
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9 Input/Output data 
 
The first 128 bytes of the input assignment are used for diagnostic data. 
 
The following 64 bytes are used for SD bus data; see chapter 9.3. 
 
Currently, 128 bytes of diagnostic data are always sent, regardless of how much data the 
higher-level standard control system actually requires. 
Data that are not required by the base device are set with the value 0.  
 
Diagnostic data is composed in SafePLC2. 
 
Irrespective of the device and selected profile, 68 bytes of output data are available. The 
upper 64 bytes of this are used for the SD bus. 
 

9.1 PSC1-C-10-x-FB1/2  
 

9.1.1 Input data (PSC1 -> PLC) 
 
Structure of the overall frame: 
 
Total diagnostic data size: always 128 bytes, of which 16 bytes can be used for diagnostics  
 

Byte Bit "Run" mode (2, 3, 4) Error case  ( A, F) 

Byte 0 0...3 PSC1 mode  1, 2, 3, 4, 5, 6 = Fatal error, 7 = Alarm 

4 1 

5..7 Alive counter (3 Bit) 

Byte 1 0...7 Logic data (Bit ID: 48...55) 

Byte 2 0...7 Logic data (Bit ID: 40...47) 

Byte 3 0...7 Logic data (Bit ID: 32...39) 

Byte 4 0...7 Logic data (Bit ID: 8...15) 

Byte 5 0...7 Logic data (Bit ID: 0...7) 

Byte 6* 0..6 Logic data (Bit ID: 24... 30) Error code: high Byte 

7 0 1 

Byte 7* 0..7 Logic data (Bit ID: 16..23) Error code: low Byte 

Table 11: PSC1-C-10-x-FB1/2 logic data 

The bits ‘PSC1 mode’ show the status of the control. The states 1-5 are issued on the 7-
segment display in parallel. Status 6 indicates an error, status 7 an alarm. The explanation of 
the respective error codes can be found in the SafePLC2 manual.  

*Note: 
In normal operation, the logic data is transmitted in byte 6 and byte 7. In the event of 
an error or alarm logic data is overwritten with the corresponding code until the 
alarm/error is cleared. Bit 7 of Byte 6 can be used to distinguish between the two 
modes. 
 

Please take this into account when using the respective bits for visualization or 
process control. 
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The process data follow the logic data with a byte offset of 7; byte 0 of the process data is 
byte 8 of the total frame/input assignment.
 
Overview 

 

Byte Assignment 

Byte 0 Status 

Byte 1 Logic data (Bit ID: 48...55) 

Byte 2 Logic data (Bit ID: 40...47) 

Byte 3 Logic data (Bit ID: 32…39) 

Byte 4 Logic data (Bit ID: 8...15) 

Byte 5 Logic data (Bit ID: 0...7) 

Byte 6 Logic data (Bit ID: 24...30) / Error code 

Byte 7 Logic data (Bit ID: 16...23) / Error code 

Byte 8 Process data (Bit: 56…63) 

Byte 9 Process data (Bit: 48…55) 

Byte 10 Process data (Bit: 40…47) 

Byte 11 Process data (Bit: 32…39) 

Byte 12 Process data (Bit: 24…31) 

Byte 13 Process data (Bit 16…23) 

Byte 14 Process data (Bit: 8...15) 

Byte 15 Process data (Bit: 0...7) 

Byte 16 not used 

… … 

Byte 127 not used 

Byte 128 SD-Gateway - Diagnostic 

Byte 129 SD-Gateway - Data 

Byte 130 SD-Slave 1 - Data 

Byte 131 SD-Slave 1 - Diagnostic 

Byte 132 SD-Slave 2 - Data 

Byte 133 SD-Slave 2 - Diagnostic 

… … 

Byte 190 SD-Slave 31 - Data 

Byte 191 SD-Slave 31 - Diagnostic 

Table 12: PSC1-C-10-x-FB1/2 logic and process data 
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9.1.2 Output data (PLC -> PSC1) 
 

 

Byte Assignment 

Byte 0 Logic data (Bit ID: 0...7) 

Byte 1 Logic data (Bit ID: 8...15) 

Byte 2 Logic data (Bit ID: 16...23) 

Byte 3 Logic data (Bit ID: 24...31) 

Byte 4 SD-Gateway - Instruction 

Byte 5 SD-Gateway - Address 

Byte 6 SD-Slave 1 - Request 

Byte 7 SD-Slave 1 - Reserved 

Byte 8 SD-Slave 2 - Request 

Byte 9 SD-Slave 2 - Reserved 

… … 

Byte 66 SD-Slave 31 - Request 

Byte 67 SD-Slave 31 - Reserved 

Table 13: PSC1-C-10-x-FB1/2 output data 

 

  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 28 of 171 

 

9.2 PSC1-C-100-x-FB1/2 
 
Three different profiles can be used; they are selected in SafePLC2. 
  

9.2.1 Profile 0 (= free assignment) 
 

9.2.1.1 Input Data (PSC1 -> PLC) Profile 0 with axis extension modules  
 
Total size of diagnostic data: always 128 bytes 
 

Byte offset Description Data size 

0 Bit data type "1"   
(Logic data bit ID0 to bit ID55) 

8 byte 

8 Process data Slave module Addr. 1 12 byte 

20 Bit data type "1" 
(Logic data bit ID56 to bit ID111) 

8 byte 

28 Process data Slave module Addr. 2 12 byte 

40 Bit data type "1" 
(Logic data bit ID112 to bit ID167) 

8 byte 

48 Process data Slave module Addr. 3 12 byte 

60 Bit data type "1"  
(Logic data bit ID168 to bit ID223) 

8 byte 

68 Process data Slave module Addr. 4 12 byte 

80 Bit data type "1" 
(Logic data bit ID224 to bit ID279) 

8 byte 

88 Process data Slave module Addr. 5 12 byte 

100 Bit data type "1"  
(Logic data bit ID280 to bit ID335) 

8 byte 

108 Process data Slave module Addr. 6 12 byte 

120 Bit data type "1"  
(Logic data bit ID336 to bit ID391) 

8 byte 

128 SD-Gateway - Diagnostic 1 byte 

129 SD-Gateway - Data 1 byte 

130 SD-Slave 1 - Data 1 byte 

131 SD-Slave 1 - Diagnostic 1 byte 

 132 SD-Slave 2 - Data 1 byte 

133 SD-Slave 2 - Diagnostic 1 byte 

… … 1 byte 

190 SD-Slave 31 - Data 1 byte 

191 SD-Slave 31 - Diagnostic 1 byte 

Table 14: Structure for device profile 0 (= free assignment) with extension modules 

Offset for error number of the slave module: Offset bit data + 6 

Please see 9.2.1.1.3 for explanation of data types  
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9.2.1.2 Input Data (PSC1 -> PLC) Profile 0 without axis extension modules 
 
Structure of the overall frame: 
 
Total size of diagnostic data: always 128 bytes 
 

Byte offset Description Data size 

0 Bit data type "1"  
(Logic data bit ID0 to bit ID55) 

8 byte 

8 Bit data type "2"  
(Logic data bit ID56 to bit ID111) 

7 byte 

15 Bit data type "2"  
(Logic data bit ID112 to bit ID167) 

7 byte 

22 Bit data type "2"  
(Logic data bit ID168 to bit ID223) 

7 byte 

29 Bit data type "2"  
(Logic data bit ID224 to bit ID279) 

7 byte 

36 Bit data type "2"  
(Logic data bit ID280 to bit ID335) 

7 byte 

43 …127 Not assigned 
 

128 SD-Gateway - Diagnostic 1 byte 

129 SD-Gateway - Data 1 byte 

130 SD-Slave 1 - Data 1 byte 

131 SD-Slave 1 - Diagnostic 1 byte 

 132 SD-Slave 2 - Data 1 byte 

133 SD-Slave 2 - Diagnostic 1 byte 

… … 1 byte 

190 SD-Slave 31 - Data 1 byte 

191 SD-Slave 31 - Diagnostic 1 byte 

Table 15: Structure for device profile 0 (= free assignment) without extension modules 

Offset for error number of the master module: Offset bit data + 6 (only in bit data type "1") 

Please see 9.2.1.1.3 for explanation of data types   
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9.2.1.3 Profile 0 - Data types 
 

• Bit data type "1" 
 

Byte Bit "Run" mode (2, 3, 4) Error case  ( A, F) 

Byte 0 0...3 PSC1 mode  1, 2, 3, 4, 5, 6 = Fatal error, 7 = Alarm 

4 1 

5..7 Alive counter (3 Bit) 

Byte 1 0...7 Logic data (Bit ID: 48...55) 

Byte 2 0...7 Logic data (Bit ID: 40...47) 

Byte 3 0...7 Logic data (Bit ID: 32...39) 

Byte 4 0...7 Logic data (Bit ID: 8...15) 

Byte 5 0...7 Logic data (Bit ID: 0...7) 

Byte 6* 0..6 Logic data (Bit ID:24.. 30) Error code: high Byte 

7 0 1 

Byte 7* 0..7 Logic data (Bit ID: 16..23) Error code: low Byte 

Table 16: Bit data type "1" 

 
The bits ‘PSC1 mode’ show the status of the control. The states 1-5 are issued on the 7-
segment display in parallel. Status 6 indicates an error, status 7 an alarm. The explanation 
of the respective error codes can be found in the SafePLC2 manual 
 

 
 

• Bit data type "2" 
 

Byte Bit Assignment 

Byte 0 0...7 Logic data (Bit: 48...55) 

Byte 1 0...7 Logic data (Bit: 40...47) 

Byte 2 0...7 Logic data (Bit: 32...39) 

Byte 3 0...7 Logic data (Bit: 8...15) 

Byte 4 0...7 Logic data (Bit: 0...7) 

Byte 5 0..6 Logic data (Bit: 24...30) 

7 0 

Byte 6 0..7 Logic data (Bit: 16...23) 

Table 17: Bit data type "2" 

 
 

  

*Note: 
In normal operation, the logic data is transmitted in byte 6 and byte 7. In the event of 
an error or alarm logic data is overwritten with the corresponding code until the 
alarm/error is cleared. Bit 7 of Byte 6 can be used to distinguish between the two 
modes. 
 

Please take this into account when using the respective bits for visualization or 
process control. 
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• Process data 
 

Byte Data 

Byte 0 Process data bit 0...7 

Byte 1 Process data bit 8…15 

Byte 2 Process data bit 16...23 

Byte 3 Process data bit 24...31 

Byte 4 Process data bit 32...39 

Byte 5 Process data bit 40...47 

Byte 6 Process data bit 48...55 

Byte 7 Process data bit 56...63 

Byte 8 Process data bit 64...71 

Byte 9 Process data bit 72...79 

Byte 10 Process data bit 80...87 

Byte 11 Process data bit 88...95 

Table 18: Process data 

 
 

9.2.1.4 Output data (PLC -> PSC1) Profile 0 
 

Byte Assignment 

Byte 0 Logic data (Bit ID: 0...7) 

Byte 1 Logic data (Bit ID: 8...15) 

Byte 2 Logic data (Bit ID: 16...23) 

Byte 3 Logic data (Bit ID: 24...31) 

Byte 4 SD-Gateway - Instruction 

Byte 5 SD-Gateway - Address 

Byte 6 SD-Slave 1 - Request 

Byte 7 SD-Slave 1 - Reserved 

Byte 8 SD-Slave 2 - Request 

Byte 9 SD-Slave 2 - Reserved 

… … 

Byte 66 SD-Slave 31 - Request 

Byte 67 SD-Slave 31 - Reserved 
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9.2.2 Profile 1 (= only logic data)  
 

9.2.2.1 Input data (PSC1 -> PLC) Profile 1 
 

Byte Bit "Run" mode (2, 3, 4) Error case  ( A, F) 

Byte 0 0..3 PSC1 mode  1, 2, 3, 4, 5, 6 = Fatal error, 7 = Alarm 

4 1 

5..7 Alive counter (3 Bit) 

Byte 1 0..7 0 Device address at which an error 
occurred 

Byte 2 0..7 Reserved 

Byte 3 0..7 0 Error code high byte 

Byte 4 0..7 0  Error code: low byte 

Byte 5 0..7 Logic data (Bit ID: 0...7) 

Byte 6 0..7 Logic data (Bit ID: 8…15) 

Byte 7 0..7 Logic data (Bit ID: 16...23) 

Byte 8 0..7 Logic data (Bit ID: 24…30) 

... ... .... 

Byte 55 0..7 Logic data (Bit ID: 400…407) 

… … Not used 

Byte 128 0..7                                             SD-Gateway - Diagnostic 

Byte 129 0..7                                             SD-Gateway - Data 

Byte 130 0..7                                             SD-Slave 1 - Data 

Byte 131 0..7                                             SD-Slave 1 - Diagnostic 

Byte 132 0..7                                             SD-Slave 2 - Data 

Byte 133 0..7                                             SD-Slave 2 - Diagnostic 

…                                              … 

Byte 190 0..7                                             SD-Slave 31 - Data 

Byte 191 0..7                                             SD-Slave 31 - Diagnostic 

Table 19: Structure for device profile 1 (= only logic data)  

 
The bits ‘PSC1 mode’ show the status of the control. The states 1-5 are issued on the 7-
segment display in parallel. Status 6 indicates an error, status 7 an alarm. 
 
Note: 
The meaning of the error codes in decimal notation can be found in the programming 
manual. 
 
The following logic data bit IDs are reserved for compatibility reasons and cannot be used 
(value always 0): 

• Bit ID 31 

• Bit ID 87 

• Bit ID 143 

• Bit ID 199 

• Bit ID 255 

• Bit ID 311 

• Bit ID 367 
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9.2.2.2 Output data (PLC -> PSC1) Profile 1 
 

Byte Assignment 

Byte 0 Logic data (Bit ID: 0...7) 

Byte 1 Logic data (Bit ID: 8...15) 

Byte 2 Logic data (Bit ID: 16...23) 

Byte 3 Logic data (Bit ID: 24...31) 

Byte 4 SD-Gateway - Instruction 

Byte 5 SD-Gateway - Address 

Byte 6 SD-Slave 1 - Request 

Byte 7 SD-Slave 1 - Reserved 

Byte 8 SD-Slave 2 - Request 

Byte 9 SD-Slave 2 - Reserved 

… … 

Byte 66 SD-Slave 31 - Request 

Byte 67 SD-Slave 31 - Reserved 
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9.2.3 Profile 2 (= logic data + process data for each slave)   
 

9.2.3.1 Input data (PSC1 -> PLC) Profile 2 
 

Byte Bit "Run" mode (2, 3, 4) Error case  ( A, F) 

Byte 0 0..3 PSC1 mode  1, 2, 3, 4, 5, 6 = Fatal error, 7 = Alarm 

4 1 

5..7 Alive counter (3 Bit) 

Byte 1 0..7 0 Device address at which an error 
occurred 

Byte 2 0..7 Reserved 

Byte 3 0..7 0 Error code: low byte 

Byte 4 0..7 0  Error code high byte 

Byte 5 0..7 Logic data (Bit ID: 0...7) 

Byte 6 0..7 Logic data (Bit ID: 8...15) 

Byte 7 0..7 Logic data (Bit ID: 16...23) 

Byte 8 0..6 Logic data (Bit ID: 24...30) 

 7 0 

Byte 9 0..7 Logic data (Bit ID: 32...39) 

Byte 10 0..7 Logic data (Bit ID: 40...47) 

... ... .... 

Byte 55 0..7 Logic data (Bit ID: 400...407) 

Byte 56 0..7 Process data axis modules slave 1 bit 0...7 

Byte 57 0..7 Process data axis modules slave 1 bit 8...15 

Byte 58 0..7 Process data axis modules slave 1 bit 16...23 

Byte 59 0..7 Process data axis modules slave 1 bit 24...31 

Byte 60 0..7 Process data axis modules slave 1 bit 32...39 

Byte 61 0..7 Process data axis modules slave 1 bit 40…47 

Byte 62 0..7 Process data axis modules slave 1 bit 48...55 

Byte 63 0..7 Process data axis modules slave 1 bit 56...63 

Byte 64 0..7 Process data axis modules slave 1 bit 64…71 

Byte 65 0..7 Process data axis modules slave 1 bit 72...79 

Byte 66 0..7 Process data axis modules slave 1 bit 80...87 

Byte 67 0..7 Process data axis modules slave 1 bit 88...95 

Byte 68 0..7 Process data axis modules slave 2 bit 0...7 

… … … 

Byte 79 0..7 Process data axis modules slave 2 bit 88…95 

Byte 80 0..7 Process data axis modules slave 3 bit 0…7 

… … … 

Byte 91 0..7 Process data axis modules slave 3 bit 88...95 

Byte 92 0..7 Process data axis modules slave 4 bit 0...7 

… … … 

Byte 103 0..7 Process data axis modules slave 4 bit 88…95 
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Byte 104 0..7 Process data axis modules slave 5 bit 0...7 

… … … 

Byte 115 0..7 Process data axis modules slave 5 bit 88...95 

Byte 116 0..7 Process data axis modules slave 6 bit 0...7 

… … … 

Byte 127 0..7 Process data axis modules slave 6 bit 88...95 

Byte 128 0..7                                             SD-Gateway - Diagnostic 

Byte 129 0..7                                             SD-Gateway - Data 

Byte 130 0..7                                             SD-Slave 1 - Data 

Byte 131 0..7                                             SD-Slave 1 - Diagnostic 

Byte 132 0..7                                             SD-Slave 2 - Data 

Byte 133 0..7                                             SD-Slave 2 - Diagnostic 

…                                              … 

Byte 190 0..7                                             SD-Slave 31 - Data 

Byte 191 0..7                                             SD-Slave 31 - Diagnostic 

Table 20: Structure for device profile 1 (= logic data + process data for each slave)  

 
 
The bits ‘PSC1 mode’ show the status of the control. The states 1-5 are issued on the 7-
segment display in parallel. Status 6 indicates an error, status 7 an alarm. 
 
Note: 
The meaning of the error codes in decimal notation can be found in the programming 
manual. 
 
 
The following logic data bit IDs are reserved for compatibility reasons and cannot be used 
(value always 0): 

• Bit ID 31 

• Bit ID 87 

• Bit ID 143 

• Bit ID 199 

• Bit ID 255 

• Bit ID 311 

• Bit ID 367 
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9.2.3.2 Output data (PLC -> PSC1) Profile 2 
 

 

Byte Assignment 

Byte 0 Logic data (Bit ID: 0...7) 

Byte 1 Logic data (Bit ID: 8...15) 

Byte 2 Logic data (Bit ID: 16...23) 

Byte 3 Logic data (Bit ID: 24...31) 

Byte 4 SD-Gateway - Instruction 

Byte 5 SD-Gateway - Address 

Byte 6 SD-Slave 1 - Request 

Byte 7 SD-Slave 1 - Reserved 

Byte 8 SD-Slave 2 - Request 

Byte 9 SD-Slave 2 - Reserved 

… … 

Byte 66 SD-Slave 31 - Request 

Byte 67 SD-Slave 31 - Reserved 

Table 21: PSC1-C-100-FB1/2 output data 
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9.3 SD-Bus data 
 
The universal communication interface (option -FB1/2) behaves like a gateway with regard to 
the SD bus data. Communication from the SD bus to the fieldbus works in both directions. 
 

9.3.1 Fieldbus data SD-Bus Gateway 
 
For the Gateway diagnostics and for the acyclic data request of the SD slaves, 2 bytes are 
reserved in the request and the response of the fieldbus protocol. 
 
Request:  Byte 00   instruction byte, acyclic data request 

Byte 01   SD slave address for the acyclic data request 
 

Response:  Byte 00   diagnostic byte Gateway (refer to table 19) 
Byte 01   data byte, acyclic data request 

 
The detailed description of the acyclic data request of SD slaves can be found in chapter 
9.3.4. 
 

9.3.2 Fieldbus data SD slave 
 
For each SD slave, 2 bytes are reserved in the request and the response of the fieldbus 
protocol. 
 
- SD slave 01 uses byte 02 and 03 of the fieldbus 
- SD slave 02 uses byte 04 and byte 05 of the fieldbus 
… etc. 
- SD slave 31 uses byte 62 and byte 63 of the fieldbus 
 
In the request, only the first byte is needed in the fieldbus as request byte for an SD slave. 
The second byte is not used. 
 
In the response, first the response byte and subsequently the diagnostic byte of each SD 
slave is transmitted to the fieldbus. 
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9.3.3 Structure of the SD bytes in the fieldbus protocol 
 
Request for all fieldbus systems (OUTPUT byte control, transmission of the request data to the SD slave) 
 

Byte no. Byte 00 Byte 01 Byte 02 Byte 03 ... Byte 62 Byte 63 

SD device Gateway Gateway Slave 01 Slave 01 ... Slave 31 Slave 31 

Content Instruction byte SD-Addr. (0, 1-
31) 

Request 
byte 

---  Request 
byte 

--- 

 
 
Response for all fieldbus systems (INPUT byte control, reception of the response data of the SD slave) 
 

Byte no. Byte 00 Byte 01 Byte 02 Byte 03 ... Byte 62 Byte 63 

SD device Gateway Gateway Slave 01 Slave 01 ... Slave 31 Slave 31 

Content Diagnostic 
byte 

Date byte Response byte Diagnostic 
byte 

 Response byte Diagnostic 
byte 

 

The content of the diagnostic byte of an SD slave depends on the status of the warning and the error bits in the corresponding response byte 
(Bit 6 = error warning and Bit 7 = error). 

The meaning of the individual bits of the SD bytes is explained in the mounting instructions of the SD devices 

.
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9.3.4 Reading acyclic data from the SD slave 
 
In a permanently defined cycle, acyclic data of the individual SD slave can be requested 
through the 2 request bytes (fieldbus request byte 00 and byte 01) and the data byte 
(fieldbus response byte 01). 
 
The instruction byte defines, which data will be requested from a slave. The SD device, from 
which the data are requested, is defined in the SD interface by means of the SD address 
byte. The response data of the SD slaves are saved in the fieldbus response byte 01. 
 
The data request cycle is defined as follows: 
 

1. The control deletes the data byte before or after each command. A feedback signal is 
generated through the response byte, indicating whether the data have been deleted 
or not. 
Hex FF:  Data deleted, acyclic data service ready 
 

2. The control first writes the SD address into the fieldbus request byte 01. 
Then, the control writes the instruction byte into the fieldbus request byte 00 
 

3. The response data are made available in the fieldbus response byte 01 of the control. 
The data byte can also include an error message as response: 
Hex FE: Instruction error, undefined instruction requested 
Hex FD: Address error, invalid slave address for the selected instruction 
   or slave address of a unavailable SD slave selected 
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Instructions, 
acyclic data request 

Instruction 
byte 
fieldbus 
byte 00 
(request) 

SD address 
fieldbus byte 
01 
(request) 

Data byte 
fieldbus byte 01 
(response) 

Data description 

Delete data byte Hex: 00 Hex: xx Hex: FF Data deleted, ready for new instruction 

Read number of projected SD slaves Hex: 01 Hex: 00 Hex: 01 to Hex: 1F Number of projected SD slaves 1 – 31 

Read device category of the SD slave Hex: 02 Hex: 01 to 
Hex: 1F 

Hex: 30 to Hex: F8 SD slave device category (see below) 

Read hardware revision of the SD slave Hex: 03 Hex: 01 to 
Hex: 1F 

Hex: 41 to Hex: 5A Hardware revision A –Z as ASCII 
characters 

Read software version of the SD slave 
(high byte) 

Hex: 04 Hex: 01 to 
Hex: 1F 

Hex: 00 to Hex: 63 Software version, high byte: 0-99 

Read software version of the SD slave 
(low byte) 

Hex: 05 Hex: 01 to 
Hex: 1F 

Hex: 00 to Hex: 63 Software-Version, Low-Byte: 0 - 99 

Table 22: Overview of the instructions and response data 

 
 
The device category of a SD slave can be found in the mounting instructions of the device concerned. 
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The following device categories are defined: 
Hex: 30 CSS 34, Safety sensor 
Hex: 31 AZM 200, Solenoid interlock „Z“-variant 
Hex: 32 MZM 100, Solenoid interlock „Z“-variant 
Hex: 33 AZ 200, Safety sensor 
Hex: 34 CSS 30S, Safety sensor 
Hex: 35 MZM 100 B, Solenoid interlock „B“-variant 
Hex: 36 AZM 300B, Solenoid interlock „B“-variant 
Hex: 37 RSS 36, Safety sensor 
Hex: 38 AZM 300Z, Solenoid interlock „Z“-variant 
Hex: 39 RSS 16, Safety sensor 
Hex: 3A RSS 260, Safety sensor 
Hex: 3D MZM 120 B, Solenoid interlock „B“-variant 
Hex: 3E MZM 120 BM, Solenoid interlock „B“-variant 
Hex: 3F AZM 201Z, Solenoid interlock „Z“-variant 
Hex: 40 AZM 201B, Solenoid interlock „B“-variant 
Hex: 41 Operator panel BDF200-SD  
Hex: 43 AZ 201, Safety sensor 
 
 
The individual bits in the diagnostic byte for the SD-Gateway have the following meaning: 
 

BIT Error Description 

Bit 0 Failure SD-Interface SD Interface centralized alarm, message 1 sec. delayed, 
invalid SD data. 

Bit 1  –  

Bit 2 –  

Bit 3 –  

Bit 4 SD initialisation error 
 

Reinitialization of the SD chain required! Shut down 
operating voltage of the gateway and SD Slaves. Possibly 
no SD slave connected! 

Bit 5 SD Teach error SD chain structure has changed. 

Bit 6 SD short circuit Short-circuit on the SD interface wires. Switch off and 
eliminate error. 

Bit 7 SD communication error 
 

One or more SD slaves unavailable. Invalid data from the 
SD slaves. 
Check SD installation. 

Table 23: SD Master Diagnose, SD System error / Content Response byte 00, Diagnostic byte Gateway 
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10 Assigning IP address (-FB1 option only) 
 
 
On delivery, the fieldbus Profinet is activated for devices with the -FB1 option. An IP address 
can be assigned to such a device via the IP Administrator tool. 
 
When using the Ethernet/IP interface, please refer to 
 
Chapter 12: Commissioning and configuration EtherNet/IP in SafePLC2 and RSLogix500 
 
 
 
Start the tool via the IP-Administrator button in the Connection tab. 
 

 
Figure 9: executing IP-Administrator via the connection tab 

 

 
 
At startup, the system checks whether a WinPcap driver is installed on the computer. 
WinPcap is also used by tools such as Wireshark and is used to receive IP packets for 
network analysis. If WinPcap is not installed, this driver can be downloaded from the website 
www.winpcap.org. 
 
Note: 
The compatibility mode of Npcap (https://nmap.org/npcap/) must not be used. However, a 
parallel installation can exist. 
 

 
Figure 10: missing WinPcap driver message 

 
 
 
 
First select the network card which is connected to the respective PSC1.  
 
Note: Only network cards are listed that are connected to an active network. The IP address 
of the selected network card must be in the same IP address range (subnet mask) as the 
PSC1. 
 

http://www.winpcap.org/
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Figure 11: Select network card 

 
The Scan Network button runs the search. All devices found will be listed in the Device list 
 
 

 
Figure 12: List of found devices 

 
In this list the parameters for IP-Address and/or Name of Station can be modified here for the 
selected device. Changes were taken over by pressing the respective buttons Set IP and Set 
Name. 
 
 
Note: The MAC-Address printed on the devices represents the MAC-Address of the SDDC 
connection ports. The MAC-Address of the fieldbus ports is derived following the example: 
 
 
  

00:16:22:22:12:34

00:16:22:A2:12:34

& 80h
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11 Commissioning and configuration PROFINET in SafePLC2 and 
TIA Portal (from Step 7 V10) 

 
PROFINET is available for all PSC1 base devices with the "-FB1" option. 
The "-FB1" option is always permanently integrated in the base device and represents the 
gateway from the CAN-based backplane bus of the PSC1 series to PROFINET.  
It enables the user to exchange data bidirectionally via PROFINET with a higher-level 
controller.  
 
 
In the properties of the PSC1 base device, the: 
 

• Local Network - the property fieldbus 
 
is activated,   

 
and in the fieldbus properties (Fieldbus PROFINET) under: 
 

• TYPE - PROFINET 
 
as well as under 
 

• Network Patterns (network prototype) - non-safe  
 
for non-safe data transmission  

 
must be selected. 
 
 

 
 
Figure 13: Properties PSC1 basic device - PROFINET 
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Figure 14: Properties fieldbus (Fieldbus PROFINET) - non-safe 

 
 
Parametrisation for safe data transmission (PROFIsafe)  
 

 
 
Figure 15: Properties fieldbus (Fieldbus PROFINET) - safe  
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Parametrisation for non-safe and safe data transmission (PROFIsafe) 
 

 

Figure 16: Properties fieldbus (Fieldbus PROFINET) - both 
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The functional inputs and outputs must still be inserted in the "Functional scheme" and 
logically connected. 
 

  
 
 
The project and the network configuration must be transferred:  
"Click the "Device Interface" icon 
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Click the "Connect" icon in the new dialogue. 
 

  

 
 
The successful connection to PSC1 is displayed in the following dialogue ("Connect icon" 
faded out /"Disconnect icon" faded in). 
 

 
 
 
Now the network configuration and the source code can be transferred. 
 

 
 
 
The transfer status (progress bar) is displayed in the lower information bar. 
 

 
 
 
After transmission, the PSC1 may have to be restarted ("Green arrow icon"). 

 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 49 of 171 

 

11.1 Parameter configuration 
 
The parameters are set using the "TIA Portal" program from Siemens AG. 
 

11.1.1 Installing the XML file  
 
Click on "Tools" => "Manage device description files (GSD)". 
 

 
 
 
Select "Source path" and confirm the selection with "Install". 
 

 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 50 of 171 

 

The device catalogue is updated. 
 

 
 
 
The installation result of the XML file is displayed. 
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11.1.2 Create project and insert PSC1 with PROFINET 
 
Create a new project with "Project" => "New". 
 

 
 
 
Assign a project name.  
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Call up the hardware catalogue in the "Network overview". 
 

 
 
 
Enter "PSC1" in the search field of the hardware catalogue and confirm with "Enter". 
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Confirm the selection by double-clicking.  
 

 
 
 
The inserted device is displayed in the "Network Overview". 
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The PSC1-C-xxx-FB must still be assigned. Click on "not assigned" and select the master 
control. 
 

 
 
 
The successful assignment is indicated by a connection line. 
 

 
 
 
Double-click on PSC1-C-xxx-FB... to access the "Device overview". 
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11.1.3 Setting up safe data transmission 
 
If you do not want to set up safe data transfer, proceed with  
"11.1.4 Setting up an online connection". 
 
A safe communication module "F modules" from the device catalogue must be inserted in the 
device overview. 
 

  

Click on the safe communication module to access the properties of the security module. The 
"PROFIsafe" tab must be used to adjust the target address and the monitoring time. 
 
The destination address must correspond to the address preset in SafePLC2 (in the example 
the address 10) 
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A program call must be defined in the Safety Administration Editor of the program. 
 

  
 
 
To reintegrate the safe module after an F-peripheral/channel error, an acknowledgement 
must still be programmed. The acknowledgement request for reintegration is detected via the 
variable "ACK_REQ" and the acknowledgement for reintegration is sent via the variable 
"ACK_REI". 
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11.1.4 Setting up an online connection 
 
To establish an online connection to the master control, click on "Connect Online" and start 
the search for compatible devices. 
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The IP address of the preselected communication card of the PC/PG may still have to be 
adapted. 
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Before a PROFINET IO Device can be addressed by a PROFINET IO Controller, a device 
name must be assigned to the PROFINET IO Device. Double-click on the desired device in 
the "Device Overview" and then right-click to open the menu dialogue shown below. 
 

 
 
 
Select the "Assign device name" function. 
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In the following dialogue, accept or edit the PROFINET device name and confirm the 
selection with "Assign name". 
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After a successful change, the status changes to "OK". 
 

 
 
 
Signal states can now be observed in the "Observe Variables" dialogue. 
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11.1.5 Examples of non-safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 0 (functional output) and can be read in byte 5 (bit 0) of the configuration tool 
(TIA Portal). 
 

 
 
 

 
 
 
In addition, up to 32 non-safe functional inputs are available on the PSC1, via which digital 
information can be received from the higher-level standard controller.  
In the "SafePLC2" function diagram, these inputs must always be AND-linked to a safe input 
and can then be reused as required. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). Both have a 
high signal, relay 1 is activated. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). "Confirm Button 
1" has a low signal, the functional output from the standard control has a high signal, Relay 1 
is not activated. 
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11.1.6 Examples of safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
PSC1 in bit 1 (f bus output 1) and can be read in byte 0 (bit 0, F bus 00..07) of the 
configuration tool (TIA Portal). 
 

 
 
 
 

 
 
 
The last four bytes are intended for CRC control. 
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In addition, up to 96 safe functional inputs are available on the PSC1, via which digital 
information can be received by the higher-level safety controller.  
 
In the following example, the functional output (F_Bus byte 0. bit 0) is written in the safety 
controller and read in the PSC1 in bit 0 (F bus input 1) and output to relay 2. 
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12 Commissioning and configuration EtherNet/IP in SafePLC2 and 
RSLogix500 

 
EtherNet/IP is available for all PSC1 base devices with the "-FB1" option. 
The "-FB1" option is always permanently integrated in the base device and represents the 
gateway from the CAN-based backplane bus of the PSC1 series to EtherNet/IP.  
It enables the user to exchange data bidirectionally via  EtherNet/IP with a higher-level 
controller.  
 

In the properties of the PSC1 base device, the: 
 

• Local Network - the property fieldbus is activated,   
 
and in the fieldbus properties (Fieldbus EtherNet/IP) under: 
 

• Type – EtherNet/IP 
 
must be selected. 
 
 

 
 
Figure 17: Properties PSC1 basic device - EtherNet/IP 
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Figure 18: Properties fieldbus (Fieldbus EtherNet/IP) - non-safe 
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The functional inputs and outputs must still be inserted in the "Functional scheme" and 
logically connected. 
 

  

 
 
The project and the network configuration must be transferred:  
"Click the "Device Interface" icon 
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Click the "Connect" icon in the new dialogue. 
 

  

 
 
The successful connection to PSC1 is displayed in the following dialogue ("Connect icon" 
faded out /"Disconnect icon" faded in). 
 

 
 
 
Now the network configuration and the source code can be transferred. 
 

 
 
 
The transfer status (progress bar) is displayed in the lower information bar. 
 

 
 
 
After transmission, the PSC1 may have to be restarted ("Green arrow icon"). 
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12.1 Parameter configuration 
 
The parameters are set using the RSLogix5000 program from Rockwell Automation, Inc. 
 

12.1.1 Create project 
 
On the menu, click File > New > Project and create a new RSLogix5000 project. 
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In the tree view, right-click on "... Bus" and in the context menu on "New Module". 
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Select the desired communication card and click on "Create". 
 

 
 
 
Then enter the IP address of your network card and confirm with "OK". 
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12.1.2 Installing the EDS file  
 
Click on "Tools" => "EDS Hardware Installation Tool". 
 

 
 
 
If necessary, confirm that you want to start the installation tool. 
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Select "Register to EDS file(s)" and click "Next". 
 

 
 
 
Select the EDS file and click "Next". 
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The EDS file is checked. 
 

 
 
 
In the following, it is possible to change the graphical image of the slave (not recommended). 
Click on "Next". 
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The following window gives a short summary of the installation. Click on "Next". 
 

 
 
 
Then click on "Finish". 
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12.1.3 Insert PSC1 
 
In the tree view, right-click "Ethernet" and then "New Module" in the context menu. 
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Select PSC1-C-xxx-FB1-EIP in the device catalogue and click on "Create". 
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Then enter the IP address of the slave. Afterwards click on "Change" to set the 
communication area of the slave.  
The Rockwell Automation BOOTP-DHCP tool can be used to assign the IP address (for 
more information see 12.2Assigning IP addresses with the BOOTP-DHCP tool 
 

  
 
 
Select "Exclusive Owner" and click "OK". 

   

https://www.rockwellautomation.com/global/relianceelectricdrives/bootp-utility.page


Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 82 of 171 

 

If necessary, click "Yes" to confirm your selection. 
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12.1.4 Setting up an online connection 
 
Transfer your project by selecting "Communications" => "Go Online" in the menu. 
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RSLogix5000 compares the online and offline projects. Confirm the data transfer with 
"Download". 
 

 
 
 
If necessary, also confirm the following warning with "Download". 
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Signal states can be observed in the "Controller Tags" dialogue. 
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12.1.5 Examples of non-safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 0 and can be read in byte 5 (bit 0) of the configuration tool (RSLogix5000). 
 

 
 
 
In addition, up to 32 non-safe functional inputs are available on the PSC1, via which digital 
information can be received from the higher-level standard controller.  
In the "SafePLC2" function diagram, these inputs must always be AND-linked to a safe input 
and can then be reused as required. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). Both have a 
high signal, relay 1 is activated. 
 

 
 
 
In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). "Confirm Button 
1" has a low signal, the functional output from the standard control has a high signal, Relay 1 
is not activated. 
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12.2 Assigning IP addresses with the BOOTP-DHCP tool 
 
Start the "BOOTP-DHCP Tool" and select "Tools" => "Network Settings". 
 

 
 
 
Enter the "Subnet Mask" and the IP address of the gateway.  
Confirm your entries with "OK". 
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In the "Request History" select the desired slave and click on "Add to Relation List" 
(Alternatively you can double-click on the desired slave).  
Enter the IP address of the slave and confirm your entries with "OK". 
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The slave is now displayed with the corresponding IP address in the "Relation List". To 
assign the address permanently, click on "Disable BOOTP/DHCP". 
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12.3 Assigning IP addresses using the IP administrator 
 
Start the tool via the IP-Administrator button in the ‘Connection’ tab. 
 

 
 executing IP-Administrator via the connection tab 

 
 
At startup, the system checks whether a WinPcap driver is installed on the computer. 
WinPcap is also used by tools such as Wireshark and is used to receive IP packets for 
network analysis As WinPcap is not necessary for Ethenet/IP you may ignore the message. 
 
Note: 
The compatibility mode of Npcap (https://nmap.org/npcap/) must not be used. However, a 
parallel installation can exist. 
 

 
missing WinPcap driver message 

 
 
First select the network card which is connected to the respective PSC1.  
 
Note: Only network cards are listed that are connected to an active network. The IP address 
of the selected network card must be in the same IP address range (subnet mask) as the 
PSC1. 
 

 
Select network card 
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The Scan Network button runs the search. All devices with activated DHCP, but without 
assigned IP address, are then listed in the DHCP Requests list. The desired IP address can 
now be entered in the IP-Address text field and is transferred via DHCP to the connected 
PSC1 via the Set IP Address via DHCP button. This process may take a moment. 
 

  
PSC1 without assigned IP-Address and  
DHCP activated 

PSC1 with assigned IP-Address 

 
 
The device now appears automatically in the Device List. All PSC1 devices already having 
an IP address assigned are listed here.  
 
Note: The MAC-Address printed on the devices represents the MAC-Address of the SDDC 
connection ports. The MAC-Address of the fieldbus ports is derived following the example: 
 
 
 
 
 
 
 
If the IP address is to be permanently assigned, the DHCP service must be deactivated via 
Disable DHCP on selected device. Message about the successful deactivation is displayed in 
the Notifications area. 
 
 
Changing an IP address 
 
To assign a new IP address to a PSC1 device, the device first must be selected in the 
Device List and then via Enable DHCP on selected device DHCP must be activated for this 
device. After the message about successful execution a power-on reset is recommended. 
Afterwards the device is accessible via DHCP and can be found in the DHCP Requests list.  
Please then follow the procedure described above.  

00:16:22:22:12:34

00:16:22:A2:12:34

& 80h
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12.4 Explicit Messaging 
 
Reading/Writing of fieldbus data is also possible via Explicit Messaging objects. 
 
There are two different Assembly Objects (class ID: 04h) available: 

 
Instance 64h(100d) / (PLC -> PSC1) 

4 Byte Functional Inputs and 64 Byte SD Bus request 
 
Instance 65h(101d) / (PLC <- PSC1) 

128 Byte Functional Outputs and 64 Byte SD Bus response 
 
 
With the services  

Get_Attribute_Single (0Eh/14d) 

Set_Attribute_Single (10h/16d) 

  

the data (attribute 03h) and the data length (attribute 04h) can be read or written. 

 

 



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 94 of 171 

 

13 Commissioning and configuration EtherCAT in SafePLC2 and 
TwinCat 3 

 
EtherCAT is available for all PSC1 base devices with the "-FB1" option. 
The "-FB1" option is always permanently integrated in the base device and represents the 
gateway from the CAN-based backplane bus of the PSC1 series to EtherCAT.  
It enables the user to exchange data bidirectionally via  EtherCAT with a higher-level 
controller.  
 

In the properties of the PSC1 base device, the: 
 

• Local Network - the property fieldbus 
 
is activated,   

 
and in the fieldbus properties (Fieldbus) under: 
 

• Type - ETHERCAT 
 
and under 
 

• Network Patterns (network prototype) - non-safe  
 
for non-safe data transmission  

 
must be selected. 
 
 

 
 
Figure 19: Properties PSC1 basic device - EtherCAT 
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Figure 20: Properties fieldbus (Fieldbus EtherCAT) - non-safe 
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Parametrisation for safe data transmission (FSoE)  
 

 
 
 
Parametrisation for non-safe and safe data transmission (FSoE) 
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The functional inputs and outputs must still be inserted in the "Functional scheme" and 
logically connected. 
 

 

 
 
The project and the network configuration must be transferred:  
"Click the "Device Interface" icon 
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Click the "Connect" icon in the new dialogue. 
 

  

 
 
The successful connection to PSC1 is displayed in the following dialogue ("Connect icon" 
faded out /"Disconnect icon" faded in). 
 

 
 
 
Now the network configuration and the source code can be transferred. 
 

 
 
 
The transfer status (progress bar) is displayed in the lower information bar. 
 

 
 
 
After transmission, the PSC1 may have to be restarted ("Green arrow icon"). 
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13.1 Parameter configuration 
 
The parameters are set using the "TwinCAT 3" program from Beckhoff Automation GmbH & 
Co. KG  
 

13.1.1 Create project and search for target system 
 
Before you can work with the devices, you must connect your local computer to the target 
device. 
Then you can search for devices by IP address or host name. 
The local PC and the target devices must be on the same network or connected directly via 
an Ethernet cable.  
All devices can be searched for and subsequently configured in TwinCAT 3 in this way. 
 
Prerequisites for this step: 

• TwinCAT 3 must be in Config mode 

• IP address or host name of the device known 
 
 
Search for the devices as follows: 
 

• Click in the menu on File => New => Project and create a new "TwinCAT XAE 
project". 

 

• Click on "SYSTEM" on the left side of the tree view and then on "Choose Target". 
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Click on "Search (Ethernet)". 
 

 
 
 
Click on "Broadcast Search". 
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Select the device found and then click on "Add Route". 
 

 
 
 
Enter the user name in the "User Name" field and the password for the user in the 
"Password" field. 
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13.1.2 Find connected I/O devices 
 
Import EtherCAT XML Device Description (ESI):  
The files should always be unpacked completely into the ESI directory of the EtherCAT 
Master. The directory can be found in TwinCAT 3.x under 
"\TwinCAT\3.x\Config\Io\EtherCAT". 
 
Activate in the upper navigation bar "Config Mode". 
 

 
 
 
If necessary, confirm the mode switch. 
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Right-click I/O Devices in the tree view on the left and "Scan" in the context menu. 
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Select the devices you want to use and confirm the selection with "OK". 
Only the devices that are actually present are available. 
 

 
 
 
Confirm the query with Yes to search for "Boxes". 
 

 
 
Confirm the request with "Yes" to activate "Free Run". 
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The PSC1 is displayed in the tree view as Box x (KAS ComX). 
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13.1.3 EoE 
 
EoE (Ethernet over EtherCAT) tunnels standard Ethernet communication over EtherCAT 
without interfering with normal EtherCAT communication. The EoE mechanism allows to 
access the PSC1 in an EtherCAT environment via SafePLC2. 
 
Depending on the system settings, the following error message may appear 
 

 
 
This is caused by missing entries for the EoE communication. 
 
Click on the Ethercat Slave in the tree view, then select the 'Ethercat' tab and click on 
'Advanced Settings' 
 

 
 
The settings for EoE then can be found under the entry 'Mailbox’. 
 

If TCP/IP communication is desired, enter the 
respective settings for your environment, i.e. 
either DHCP or enter an IP-address. 
 
If EoE shall not be used, deactivate the 
'Virtual Ethernet Port' selection 
 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 107 of 171 

 

13.1.4 Examples of non-safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 0 and can be read in byte 5 (bit 0) of the configuration tool (TwinCAT 3). 
 
 

 
 
 

 
 
 
In addition, up to 32 non-safe functional inputs are available on the PSC1, via which digital 
information can be received from the higher-level standard controller.  
In the "SafePLC2" function diagram, these inputs must always be AND-linked to a safe input 
and can then be reused as required. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). Both have a 
high signal, relay 1 is activated. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). "Confirm Button 
1" has a low signal, the functional output from the standard control has a high signal, Relay 1 
is not activated. 
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13.1.5 Create safety project 
 
Right-click "SAFETY" in the tree view on the left and "Add New" item in the context menu. 
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Select "TwinCAT Default Safety Project" and specify the project name. Confirm your entries 
with "Add". 
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If necessary, please select the "Target System" and the "Programming Language". Confirm 
your selection with "Ok". 
 

 
 
 
Communication between the Safety Logic and the I/O level is implemented via an alias level. 
In this alias level (sub-node \ alias devices), corresponding "Alias Devices" are created for all 
safe inputs and outputs, but also for standard signals. This can also be done automatically 
for the safe inputs and outputs using the  
 
I/O configuration. 
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Right-click on "Alias Devices" in the tree view on the left and select "Import Alias Device(s)" 
in the context menu. 
 

 
 
 
If the automatic import from the I/O configuration is started, a selection dialogue is opened 
via which the individual terminals that are to be imported automatically can be selected. 
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After closing the dialogue, the Alias Devices are created in the safety project. 
 

 
 
 
The Target System is permanently set to TwinCAT Safety PLC in the drop-down list and is 
linked to the task with which the TwinCAT Safety PLC is to be executed via the "Link" button 
next to "Append to Task". Left-click on "Target System" in the tree view and then click on 
"Physical Device" in the context menu. 
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Select the master device in the context menu and confirm your entry with "OK". 
 

 
 
 
After closing the dialogue, the Master Device is linked to the task. 
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The hardware address of the target system may have to be checked and set if necessary. If 
the address is known to you, enter it in the "Safe Address" tab. If the address is unknown, it 
can be read out. Activate the Config Mode: "TWINCAT => Restart TwinCAT (Config Mode)". 
 

 
 
 
Confirm your selection with "OK". 
 

 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 119 of 171 

 

Confirm the readout of the I/O peripherals with "Yes". 
 

 
 
 
Confirm activation of the "Free Run" mode. 
 

 
 
 
Read out the hardware address by clicking on the icon shown below. 
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Enter the hardware address read out into the "Safe Address" tab. 
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The safe FSoE address of the PSC control must correspond to the address preset in 
SafePLC2 (in the example the address 123). The automatic readout of the DIP switch 
addressing switch is not supported for PSC1 and is signalled by the system by the message 
shown below. 
 

 
 
 
Left-click on "Box xx (KAS ComX) - Module x" in the tree view and set the FSoE address 
manually in the context menu. 
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Left-click on "TwinSafeGroupX.sal" in the tree view to create a safety-related program. Insert 
logical links and assign the required variable names. 
 

 
 
 
The variables created are displayed in the lower navigation window under "Variables => 
Variable Mapping". 
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Click on "Alias Port" in the "Variable Mapping" window to link the desired variable with 
previously imported I/Os. 

 
 
 
In the group configuration, mapping must still be performed for Error Acknowledge (e.g. for 
reintegration after a communication interruption). This signal is linked via the "ERR Ack" link 
in the navigation window under "Variable Mapping => Group Ports". 
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For simplicity, this signal is linked to a global variable in the following example. Right-click on 
"PLC" in the tree view on the left and click on "Add New Item" in the context menu. 
 

  
 
 
Select "Standard PLC Project" in the following dialogue and confirm your selection with 
"Add". 
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Right-click on "GVLs" in the tree view on the left, then click on "Add" in the context menu and 
then on "Global Variable List...". 
 

 
 
 
Select "Open" in the following dialogue. 
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Enter the following instruction in the GVL: "bReset AT %Q*: BOOL; 
 

 
 
 
Compile your project: "Build => Build Solution". 
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Click on "NonSafeProject Instance => PlcTask Outputs" on the left side of the tree view  
 
=> GVL.bReset". 

 
 
 
Select "Linked to" in the following dialogue. 
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Add a shortcut to the "ERR Ack" signal link. 
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Now the safety-related program can be compiled. Click on "PSC1-C-10-FB1-ECFS Project 
(your project name)" in the tree view on the left and on the "Verify Safety Project" icon in the 
upper navigation bar. 
 

 
 
 
If your safety-related project has been compiled without errors, the project can be transferred 
to the EtherCAT-FSoE-capable master controller. To do this, click on "Download Safety 
Project" in the upper navigation bar. 
 

 
 
 
Please enter the stored user name, the serial number of the target system and the password 
and then click "Next". 
 

  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 130 of 171 

 

The serial number of the target system can be read out on the left in the tree view under 
"PSC1-C-10-FB1-ECFS (your project name) => Target System". 
 

 
 
 
After the "Download" click on "Next".  
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After "Final Verification" click on "Next".  
 

 
 
Click on "Finish" to end the "Activation". 
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By confirming the CRC with the Finish button, the safety application is activated and 
executed. During the start-up of the safety application, the CRC is distributed to the safe 
communication devices configured within the CRC distribution. If the TwinCAT system is 
restarted, the safety application is now started without reactivation. After activation, the 
TwinSAFE CRC toolbar displays the identical online and offline CRC. 
 

 
 
 
Now only the hardware must be acknowledged via the previously defined "bReset- Variable" 
(NonSafeProject Project[your project name] => PlcTask Outputs => GVL.bReset. 
 

 
 
 
Click on Force and set the value in the following dialogue to "1" and then to "0".  
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If you want to observe your variables, click on the "Show Online Data of Safety Project" icon 
in the upper navigation bar. 
 

 
 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 0 (F-Bus Output 1) and can be read in byte 0 (bit 0, 
PSC1_F_Bus_Bit_0_Input) of the configuration tool (TC3). 
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In addition, up to 96 safe functional inputs are available on the PSC1, via which digital 
information can be received by the higher-level safety controller.  
 
In the following example, the functional output (PSC1_F_Bus_Bit_0_Output byte 0. bit 0) is 
written in the safety controller and read in the PSC1 in bit 0 (F bus input 1). 
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14 Commissioning and configuration Modbus TCP/IP in SafePLC2 
 
Modbus TCP/IP is available for all PSC1 base devices (starting from COM-Firmware-
Release 1.15.1) with the "-FB1-MT" option. It allows to exchange data bidirectionally via 
Modbus TCP/IP with a superordinated control.  
 
 

In the properties of the PSC1 base device: 
 

• Local Network - the property Fieldbus must be activated,…   
 

 
 
…and in the fieldbus properties  
 

• Type – Modbus/TCP 
 
must be selected. 
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Here the following TCP/IP parameters can be set 
 
 

• DHCP If the option is selected the PSC1 receives its IP -address from a 
DHCP server in the respective network. If the option is not 
selected the IP Address is set to the value given in the row ‚IP‘ 
 

• IP TCP/IP-Address of the PSC1 
 

• Gateway IP-Address of the router. If communication in other subnets is not 
needed, the parameter can be left unset.   
 

• Subnet mask Here the subnet mask can be selected based on a list of 
preconfigured settings 

 
 
 
This configuration is then transferred via 
 
Device Interface -> Connect -> Send Network Configuration 
 

 

to the device.  
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14.1 Memory Layout 
 

Byte Content Holding 
Register 

Input 
Register 

Coil Access Supported Function Codes 

0 Functional Inputs 
0…7 

1 - 1...8 r/w Read Coils (0x01), 
Read Holding Registers (0x02), 
Write Single Coil (0x05), 
Write Single Register (0x06), 
Write Multiple Coils (0x0F), 
Write Multiple Registers (0x10) 

1 Functional Inputs 
8…15 

9...16 r/w 

2 Functional Inputs 
16...23 

2 - 17...24 r/w 

3 Functional Inputs 
24…31 

25...32 r/w 

4 Device Diagnosis(1) 3 1  r Read Holding Registers, 
Read Input Registers 5 Device Diagnosis  r 

… Device Diagnosis 4…66 2…64  r 

131 Device Diagnosis  r 

132 SD Bus Request 
Master 

67   r/w Read Holding Registers, 
Write Single Register, 
Write Multiple Registers 134 SD Bus Request 

Slave 0 
68   r/w 

… SD Bus Request 
Slave n 

69...97   r/w 

195 SD Bus Request 
Slave 30 

98   r/w 

196 SD Bus Response 
Master 

99   r Read Holding Registers 

198 SD Bus Response 
Slave 0 

100   r 

… SD Bus Response  
Slave n 

101...129   r 

259 SD Bus Response  
Slave 30 

130   r 

 
(1)See chapter 9 for further details  

 
 
Note: 
 
Due to the Modbus limitation of 260 Bytes per PDU a maximum of 125 registers can be read 
or written per single request. 
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14.2 Examples with QModMaster 
 

14.2.1 Reading functional outputs  

 
 
Read back functional outputs from the PSC1 using ‘Read Input Registers (0x04)’ 
 
 
 
 

 
 
Read back functional outputs from the PSC1 using ‘Read Holding Registers (0x03) 
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14.2.2 Writing functional inputs 

 

 

 
Set functional inputs of the PSC1 using ‘Write Multiple Coils (0x0F)’ 

 

 

 
Set functional inputs of the PSC1 using ‘Write Multiple Registers (0x10)’ 
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15 Commissioning and configuration PROIFBUS in SafePLC2 and 
TIA Portal (from Step 7 V10) 

 
PROFBUS is available for all PSC1 base devices with the "-FB2" option. 
The "-FB2" option is always permanently integrated in the base device and represents the 
gateway from the CAN-based backplane bus of the PSC1 series to PROFIBUS.  
It enables the user to exchange data bidirectionally via PROFIBUS with a higher-level 
controller.  
 

In the properties of the PSC1 base device, the: 
 

• Local Network - the property fieldbus is activated,   
 
and in the fieldbus properties (Fieldbus PROFIBUS) under: 
 

• Type - PROFIBUS 
 
and under 
 

• Network Patterns (network prototype) - non-safe  
 
for non-safe data transmission  

 
must be selected. 
 
 

 
 
Figure 21: Properties PSC1 basic device - PROFIBUS 



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 141 of 171 

 

 
 
Figure 22: Properties fieldbus (Fieldbus PROFIBUS) - non-safe 

 
 
Parametrisation for safe data transmission (PROFIsafe)  
 

 
 
Figure 23: Properties fieldbus (Fieldbus PROFIBUS) - safe 
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Parametrisation for non-safe and safe data transmission (PROFIsafe) 
 

  
 
Figure 24: Properties fieldbus (Fieldbus PROFIBUS) - both 

 
 
Note: 
The bus slave address is only relevant for safety related communication. For setting the 
Profibus address see also chapter 5.4 
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The functional inputs and outputs must be inserted in the "Functional scheme" and logically 
connected. 
 

  
 
 
The project and the network configuration must be transferred:  
"Click the "Device Interface" icon 
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Click the "Connect" icon in the new dialogue. 
 

  

 
 
The successful connection to PSC1 is displayed in the following dialogue ("Connect icon" 
faded out /"Disconnect icon" faded in). 
 

 
 
 
Now the network configuration and the source code can be transferred. 
 

 
 
 
The transfer status (progress bar) is displayed in the lower information bar. 
 

 
 
 
After transmission, the PSC1 may have to be restarted ("Green arrow icon"). 
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15.1 Parameter configuration 
 
The parameters are set using the "TIA Portal" program from Siemens AG. 
 

Installing the XML file  
 
Click on "Tools" => "Manage device description files (GSD)". 
 

 

Select "Source path" and confirm the selection with "Install". 
 

 
 
The device catalogue is then updated. 
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15.1.1 Create project and insert PSC1 with PROFIBUS 
 
Create a new project with "Project" => "New". 
 

 
 
 
Assign a project name.  
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Call up the hardware catalogue in the "Network overview". 
 

 
 
 
Enter "PSC1" in the search field of the hardware catalogue and confirm with "Enter". 
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Confirm the selection by double-clicking.  
 

 
 
 
The inserted device is displayed in the "Network Overview" 
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The PSC1-C-xxx-FB must still be assigned. Click on "not assigned" and select the master 
control. 
 

 
 
 
The successful assignment is indicated by a connection line 
 

 
 
 
Double-click on PSC1-C-xxx-FB... to access the "Device overview". 
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Click on the communication module to access the properties of the module.  
The PSC1 PROFIBUS address must be entered in the "Address" tab. 
 
The address entered must match the address preset on the PSC1 with the installed rotary 
switches (please see chapter 5.4 for further information) 
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15.1.2 Setting up safe data transmission 
 
If you do not want to set up safe data transfer, proceed with  
"15.1.3 Setting up non-safe data transmission". 
 
Click on the safe communication module to access the properties of the security module. 
 

 
 
 
The "PROFIsafe" tab must be used to adjust the target address and the monitoring time. 
The destination address must correspond to the address preset in SafePLC2 (in the example 
the address 10). 
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A program call must be defined in the Safety Administration Editor of the program. 
 

  
 
 
To reintegrate the safe module after an F-peripheral/channel error, an acknowledgement 
must still be programmed. The acknowledgement request for reintegration is detected via the 
variable "ACK_REQ" and the acknowledgement for reintegration is sent via the variable 
"ACK_REI". 
 

 
 
When you have finished the project planning, proceed with  
"15.1.4 Setting up an online connection". 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 153 of 171 

 

15.1.3 Setting up non-safe data transmission 
 
The following steps describe the project planning for the non-safety related PROFIBUS 
fieldbus. 
 
Call up the device overview of PSC1. 
 

 
 
 
Delete the PROFIsafe_1 module. 
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Insert an Empty Module. 
 

 
 
 
Compile the device configuration. 
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15.1.4 Setting up an online connection 
 
To establish the online connection to the master control, you must: Click on "Connect online" 
and start the search for compatible devices. 
 

 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 156 of 171 

 

The IP address of the preselected communication card of the PC/PG may still have to be 
adapted. 
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Signal states can now be observed in the "Observe Variables" dialogue. 
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15.1.5 Examples of non-safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 0 and can be read in byte 5 (bit 0) of the configuration tool (TIA). 
 

 
 
 

 
 
 
In addition, up to 32 non-safe functional inputs are available on the PSC1, via which digital 
information can be received from the higher-level standard controller.  
In the "SafePLC2" function diagram, these inputs must always be AND-linked to a safe input 
and can then be reused as required. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). Both have a 
high signal, relay 1 is activated. 
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In the following example, the functional output (Byte0, Bit 0) is written in the higher-level 
standard control and AND-linked to a safe input in PSC1 (Confirm Button 1). "Confirm Button 
1" has a low signal, the functional output from the standard control has a high signal, Relay 1 
is not activated. 
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15.1.6 Examples of safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
SafePLC2 in bit 1 (f bus output 1) and can be read in byte 0 (bit 0, F bus 00..07) of the 
configuration tool (TIA Portal). 
 

 
 
 

 
 
 
The last four bytes are intended for CRC control. 
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15.1.7 Examples of safe data transmission 
 
In the following example, the switching state of the button "Confirm Button 1" is written to 
PSC1 in bit 1 (f bus output 1) and can be read in byte 0 (bit 0, F bus 00..07) of the 
configuration tool (TIA Portal). 
 

 
 
 
 

 
 
 
The last four bytes are intended for CRC control. 
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In addition, up to 96 safe functional inputs are available on the PSC1, via which digital 
information can be received by the higher-level safety controller.  
 
In the following example, the functional output (F_Bus byte 0. bit 0) is written in the safety 
controller and read in the PSC1 in bit 0 (F bus input 1). 
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16 Commissioning and configuration CANopen in SafePLC2 and 
Codesys 

 
 
CANopen is available for all PSC1 base devices (starting from COM-Firmwarerelease 1.8.1) 
with the "-FB2" option. The "-FB2" option is always permanently integrated in the base device 
and represents the gateway from the CAN-based backplane bus of the PSC1 series to 
CANopen.  
It enables the user to exchange data bidirectionally via CANopen with a higher-level 
controller.  
 
 

In the properties of the PSC1 base device: 
 

• Local Network - the property Fieldbus must be activated,…   
 

 
 
 
  



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 166 of 171 

 

…and in the fieldbus properties  
 

• Type - CANOPEN 
 
must be selected. 
 

 
 
 
This configuration is then transferred via 
 
Device Interface -> Connect -> Send Network Configuration 
 

 

to the device.  
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The following section shows an example of commissioning a PSC1 with CANopen interface 
in a Codesys setting. 
 

16.1 Integrating the device description file 
 

 
 
Via the device repository first install .eds file and thereby making it available for projects. 
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16.2 Creating a new project 
 

 
 
In order to integrate a CANopen device into the hardware configuration, a CANbus master... 
 

 
 
... and a CANopen manager are required. 
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Finally, the PSC1 is added. 
 

 
 
Via ‘Edit object’ now the participant address and the process data objects (PDO) can be 
modified. The address is set according to the setting of the PSC1 (see Chapter 5.4). 
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By default, all available PDOs are displayed but according to the CANopen specification only 
the first 4 are activated for send or receive. Thus, the following data are available: 
 
RxPDO (Master => Slave) 
 

• 4 Byte functional inputs  

• SD-Bus: Master and the slaves 1-13 
 
TxPDO (Slave => Master) 
 

• 32 Byte functional Outputs 

• Note: No SD-Bus data is transferred in this setting. 
 
 
If further PDOs are required, they must be activated manually. After the activation of the 
listed PDOs, the COB-IDs for the new PDOs must often also be entered, but in most cases 
this is done automatically or by confirming the proposed COB-IDs. 
 
 



Installation manual 
 

 

Installation manual PSC1 Field buses V2.6            Page 171 of 171 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 


